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Мета роботи – експериментальним шляхом відтворити та визначити морфофункціональний стан щитовидної залози 
(ЩЗ) плода щура під впливом материнсько-плодових інфекцій, що спричинені Escherichia coli, Staphylococcus aureus 
і Klebsiella pneumoniae.

Матеріали та методи. Виконали контрольоване експериментальне дослідження з блоковою рандомізацією на 85 
самицях щурів популяції Wistar Albino Glaxo, яких залежно від групи (призначали випадково) до вагітності не інфіку-
вали чи інфікували E. coli, S. aureus і K. pneumoniae. Здійснили патоморфологічне дослідження 37 ЩЗ, що отримані 
від щурячих плодів, використовуючи комплекс методів: гістологічних (забарвлення гематоксиліном та еозином, за 
Маллорі), непрямої імунофлуоресценції з застосуванням МКА до Т4, колагену І і ІІІ типів, IL-6 та TNF, морфометрії 
(вимірювання морфофункціональних показників у програмі ImageJ). Статистичний аналіз виконали у програмному 
середовищі R із підключенням пакетів «ggplot», «dplyr», «pastecs», «graphics» для виконання тесту Шапіро–Вілка, 
застосування критерію Бартлетта та методу Бокса–Кокса, для дисперсійного аналізу (ANOVA) та побудови графіків. 
Нульову гіпотезу про відсутність відмінностей між групами відкидали, коли вірогідність помилки (p) не перевищувала 
помилку першого роду, встановлену як 0,001 (p < 0,001).

Результати. У щитовидних залозах плодів від матерів, що інфіковані E. coli, S. aureus і K. pneumoniae, порівняно з 
групою контролю визначали статистично вірогідне збільшення діаметра та площі фолікула, площі колоїду, висоти та 
площі тироциту, інтенсивності та площі світіння фолікулярних тироцитів і колоїду у препаратах, оброблених МКА до 
Т4, площі флуоресценції колагену І та ІІІ типів, а також зменшення площі ядра щодо площі цитоплазми, що позначи-
лося зменшенням ядерно-цитоплазматичного відношення. Найбільші статистичні відмінності морфофункціональних 
показників від норми спостерігали у ЩЗ плодів від матерів, інфікованих S. aureus.

Висновки. Зміни морфофункціональних параметрів щитовидної залози плодів щурів, що зазнали впливу материн-
сько-плодових інфекцій, спричинених E. coli, S. aureus і K. pneumoniae, є односпрямованими і статистично вірогідно 
відрізняються від тих, що реєструють при фізіологічному органогенезі. Вони відповідають підвищенню секреторної 
активності залози та свідчать про прискорення темпів визрівання органа.

The morphofunctional state of the fetal thyroid gland in maternal-fetal infections  
caused by Escherichia coli, Staphylococcus aureus and Klebsiella pneumoniae
P. S. Talapova, I. V. Sorokina
Aim – experimental modelling and determination of the morphofunctional state of the thyroid gland of a rat fetus in mater-
nal-fetal infections caused by E. coli, S. aureus and K. pneumoniae.

Material and methods. We conducted a controlled experimental study with block randomization on 85 female Wistar Albino 
Glaxo rats, which, depending on the group assigned randomly, were infected or not with E. coli, S. aureus and K. pneumoniae 
before pregnancy with subsequent pathomorphological examination of 37 thyroid glands obtained from rats’ fetuses. The set 
of methods was applied: histological – HE and Mallory staining; indirect immunofluorescence: moAb to T4, types I and III 
collagen, IL-6, and TNF; histomorphometry using ImageJ software. Statistical analysis was performed with the R environment 
and packages “ggplot”, “dplyr”, “pastecs”, “graphics” for Shapiro–Wilk test, Bartlett’s test, Box-Cox method, ANOVA, and plotting. 
The null hypothesis was rejected in cases when an error probability (P) did not exceed the type I error set at 0.001 (P < 0.001).

Results. In the thyroid glands of fetuses obtained from mothers infected with E. coli, S. aureus and K. pneumoniae, in com-
parison with the control group, a statistically significant increase in the following morphofunctional parameters was determined: 
the diameter and area of the follicle, the area of the colloid, the height and area of the thyrocyte, the intensity and area of 
the fluorescence of the follicular thyrocytes and colloid, in samples labeled MoAb to T4, the intensity of the fluorescence of 
collagen types I and III; a decrease in the area of the nucleus in relation to the area of the cytoplasm, which was reflected in 
a decrease in the NCR index. The most pronounced differences in morphological and functional parameters from the norm 
were found in the thyroid gland of fetuses from mothers infected with S. aureus.

Conclusions. The revealed changes in the morphofunctional parameters of the thyroid gland of a rat fetus, which experienced 
the influence of maternal-fetal infections caused by E. coli, S. aureus and K. pneumoniae, are unidirectional and statistically 
significantly different from those recorded during physiological organogenesis. They correspond to an increase in the gland’s 
secretory activity and indicate the acceleration of organ’s maturation.
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Морфофункциональное состояние щитовидной железы плода  
на фоне материнско-плодовых инфекций, вызванных Escherichia coli,  
Staphylococcus aureus и Klebsiella pneumoniae

П. С. Талапова, И. В. Сорокина
Цель работы – экспериментальным путем воспроизвести и определить морфофункциональное состояние щитовидной 
железы (ЩЖ) плода крысы под влиянием материнско-плодовых инфекций, вызванных E. coli, S. aureus и K. pneumoniae.

Материалы и методы. Проведено контролируемое экспериментальное исследование с блоковой рандомизацией на 
85 самках крыс популяции Wistar Albino Glaxo, которые в зависимости от группы (назначали случайным образом) до 
беременности подвергались или нет инфицированию E. coli, S. aureus и K. pneumoniae. Патоморфологически иссле-
довали 37 ЩЖ, полученных от их плодов, с использованием комплекса методов: гистологических (окраска гематок-
силином и эозином, по Маллори), непрямой иммунофлуоресценции с применением МКА к Т4, коллагена I и III типов, 
IL-6 и TNF, морфометрии (замеры морфофункциональных показателей в программе ImageJ). Статистический анализ 
выполнен в программной среде R с подключением пакетов «ggplot», «dplyr», «pastecs», «graphics» для проведения 
теста Шапиро–Уилка, применения критерия Бартлетта и метода Бокса–Кокса, для дисперсионного анализа (ANOVA) 
и построения графиков. Нулевую гипотезу об отсутствии различий между группами отбрасывали, когда вероятность 
ошибки (p) не превышала ошибку первого рода, установленную как 0,001 (p < 0,001).

Результаты. В щитовидных железах плодов от матерей, инфицированных E. coli, S. aureus и K. pneumoniae, по сравнению с 
группой контроля определили статистически достоверное увеличение диаметра и площади фолликула, площади коллоида, 
высоты и площади тироцита, интенсивности и площади свечения фолликулярных тироцитов и коллоида в препаратах, 
обработанных МКА к Т4, площади флуоресценции коллагенов I и III типов, а также уменьшение площади ядра в отношении 
площади цитоплазмы, что отразилось в уменьшении ядерно-цитоплазматического отношения. Наиболее выраженные 
отличия морфофункциональных параметров от нормы обнаружены в ЩЖ плодов от матерей, инфицированных S. aureus.

Выводы. Изменения морфофункциональных параметров щитовидной железы плода крысы, испытавшего влияние 
материнско-плодовых инфекций, вызванных E. coli, S. aureus и K. pneumoniae, однонаправлены и статистически 
достоверно отличаются от зарегистрированных при физиологическом органогенезе. Они соответствуют повышению 
секреторной активности железы и свидетельствуют об ускорении темпов созревания органа.

Відомо, що ключовими факторами у процесах роз-
витку суспільства є покращення здоров’я нащадків, 
особливо в часи військових конфліктів, глобального 
потепління, природних катаклізмів і пандемій. Саме 
тому патологія перинатального періоду викликає 
чималий інтерес у лікарів. Крім того, вивчення її мор-
фологічного субстрату за тих чи інших умов дає змогу 
розробляти новітні методи профілактики та своєчасної 
діагностики різних захворювань у дітей.

Протягом останніх років особливий інтерес науков-
ців і практичних лікарів прикутий до внутрішньоутроб-
них інфекцій (ВУІ), які посідають важливе місце серед 
причин перинатальної смертності у світі [1]. Вважають, 
що збудниками ВУІ є здебільшого віруси [2], але 
останнім часом усе частіше реєструють випадки вну-
трішньоутробної загибелі плода, що пов’язані з бакте-
ріальними інфекціями, як-от викликаними Escherichia 
coli, Staphylococcus aureus і Klebsiella pneumoniae 
[3–5]. Отже, структура перинатальної патології потре-
бує продовження вивчення для зменшення негативних 
наслідків відсутності діагностичної настороженості 
серед лікарів щодо хронічних латентних бактеріальних 
інфекцій у вагітних.

Крім того, через пандемію COVID-19, украй 
важливо вміти комплексно оцінювати ризики та про-
гнозувати і ранні, й віддалені наслідки інфікування 
жінок під час вагітності, що завжди супроводжується 
імуносупресією [6,7]. Через це істотно підвищується 
ризик інфікування SARS-CoV-2 з розвитком надалі ав-
тоінфекції, що викликана представниками мікробіома 
людини [8,9]. Розуміння морфологічних наслідків адап-
таційно-компенсаторних процесів, що відбуваються в 
органах і системах плода в цей час, дасть змогу вчасно 

вжити необхідних діагностично-профілактичних захо-
дів щодо передчасної інвалідизації та смерті дітей.

У фаховій літературі описані морфофункціо-
нальні стани шлунково-кишкової, сечовидільної та 
адреналової систем за умов материнських інфекцій, 
що спричинені мікробіотою людини [10–12]. Але 
щитовидна залоза (ЩЗ), яка відіграє вкрай важливу 
роль у процесах онтогенезу [13,14], в цьому контексті 
залишається не вивченою. Доцільність вивчення 
підтверджується великою кількістю вже виконаних 
експериментальних досліджень, мета яких полягала 
у визначенні особливостей гістоархітектоніки ЩЗ у 
різних етіопатогенетичних умовах порівняно з фізіо-
логічним станом [14–17]. Як експериментальних 
тварин здебільшого використовували щурів, оскільки 
вони мають геном, що на 95 % подібний до людського 
[18,19]. Для оцінювання морфофункціонального стану 
органів і систем людини впродовж перинатального 
періоду вважають доречним вивчати зміни в органах 
саме щурячих плодів [20,21].

Мета роботи
Експериментальним шляхом відтворити та визначити 
морфофункціональний стан щитовидної залози плода 
щура під впливом материнсько-плодових інфекцій, що 
спричинені Escherichia coli, Staphylococcus aureus і 
Klebsiella pneumoniae.

Матеріали і методи дослідження
На базі експериментальної біологічної клініки та 
кафедри патологічної анатомії Харківського націо-
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нального медичного університету для порівняння 
структурно-функціональної картини ЩЗ щурячих 
плодів за необхідних умов здійснили контрольоване 
експериментальне дослідження з блоковою рандомі-
зацією на лабораторних тваринах – 85 самицях щурів 
популяції Wistar Albino Glaxo (WAG, м. Харків, Україна). 
Далі виконали патоморфологічне дослідження 37 
ЩЗ від їхніх плодів. Дизайн дослідження базувався 
на відомих щурячих моделях [10–12,20]. Основа для 
експериментального дослідження – патент України 
№ 108806 «Спосіб моделювання внутрішньоутробного 
інфікування плода та новонародженого як наслідку під-
гострого інфекційно-запального процесу матері» [21].

Блокова рандомізація полягала в тому, що всі умо-
ви використовували тільки раз, перш ніж будь-яка з них 
траплялася вдруге, тобто в межах кожного блоку дослі-
дження порядок розташування умов був випадковим; 
це допомогло виключити можливість передбачення 
учасниками перебігу подій. Розміри блоків відповіда-
ли кількості тварин або об’єктів, з якими відбувалася 
взаємодія, окремо для кожного етапу експерименту. 
Для осліплення учасників дослідження та прихову-
вання інформації про контрольований вплив під час 
експерименту поділ тварин за групами відбувався 
випадковим чином за допомогою мобільного засто-
сунку «Генератор випадкових чисел». Кожній клітці, 
тварині та зразкові аналогічно присвоювали 12-значні 
цифрові коди, заздалегідь згенеровані за допомогою 
мови запитів SQL. Крім того, всіх самиць експонували 
до стресу через ін’єкційний шлях уведення суспензії з 
бактеріальними клітинами або води для ін’єкцій. Клітки 
до і після маніпуляцій випадково позмінно працівники 
віварію переставляли з місця на місце.

Для участі в експерименті встановили критерії 
включення тварин: вид – щури популяції WAG; ка-
рантин – адаптація після транспортування у груповій 
ізоляції з використанням бар’єрної системи не менше 
ніж 10 діб; однакові умови утримання, повноцінний 
харчовий раціон – комбікорм із йодованим преміксом; 
передбачуваний мікробіологічний статус – поліпшені 
конвенційні (Minimal Diseases); температура тіла на 
момент огляду – 38,5–39,5 °С; вік: для самиць – 
8–10 місяців, для самців – 10–12 місяців; вага: для 
самиць – 210–230 г, для самців – 300–335 г; фізіо-
логічний репродуктивний стан – диференційовані 
вторинні статеві ознаки, для самиць – естральний 
цикл тривалістю 4–5 днів, nulligravida; відсутність 
наявних симптомів відомих захворювань.

Необхідна кількість експериментальних тварин, 
що відповідали критеріям включення, випадково 
поділена на 4 групи. Група № 1 (далі – MС, «Mothers, 
Control», n = 10) – контрольна, представлена твари-
нами, яким одноразово підшкірно (0 доба експеримен-
ту) та тричі внутрішньоочеревинно вводили воду для 
ін’єкцій у дозі 0,1 мл (10, 20 і 30 доба експерименту). 
Групи № 2–4 (далі – MEC, «Mothers, Escherichia 
coli», n = 25; MSA, «Mothers, Staphylococcus aureus» 
(n = 25); MKP, «Mothers, Klebsiella pneumoniae», 
(n = 25) – експериментальні групи дослідження, 
самиці щурів, сенсибілізовані одноразовими підшкір-
ними ін’єкціями суспензії вбитих нагріванням клітин 
референтних штамів Escherichia coli (ATCC 25922 

(F50)), Staphylococcus aureus (ATCC 25923) і Klebsiella 
pneumoniae (NCTC 5055) у дозі 0,1 мл щільністю 1 од., 
3 од. та 1 од. за шкалою McFarland відповідно (0 доба 
експерименту). Після цього тварин кожної групи тричі 
інтраперитонеально інфікували суспензією з мікроб-
них клітин, розведених у 0,1 мл 20 % розчину маніту, в 
кількості від 300 × 106 до 1 × 109 для групи MEC, від 200 
× 106 до 800 × 106 для групи MSA, від 100 × 106 до 500 
× 106 для групи MKP (10, 20 та 30 доби експерименту).

Після цього самиць запліднювали природним 
шляхом через підсаджування здорових самців у клітки 
(31–32 доба експерименту). Факт запліднення підтвер-
джували мікроскопією вагінальних мазків. Зовнішні 
ознаки вагітності фіксували на 15 добу вагітності (46 
доба експерименту): зміна поведінки, збільшення ок-
руглості живота та молочних залоз самиць. На 20 добу 
гестаційного періоду (51 доба експерименту) частину 
тварин виводили з дослідження шляхом введення в 
бокову хвостову вену 5 % розчину тіопенталу натрію 
(UA/3916/01/01) з розрахунку 1 мг на 100 г маси тіла 
тварини та миттєвої декапітації. Окремо для підтвер-
дження факту внутрішньоутробної загибелі шляхом 
миттєвої декапітації виконували евтаназію плодів, 
яких вилучали з порожнини матки хірургічним шля-
хом. Після цього з тіл плодів відсепаровували ЩЗ як 
шийно-головні тканинні фрагменти, фіксували у 10 % 
розчині формаліну, промивали, ущільнювали шляхом 
зневоднення у спиртах концентрації, що зростає, 
заливали в парафін.

Усі зразки плодових ЩЗ поділили на групи за 
впливом, що отримувала вагітна матір: група № 1 – 
контрольна (далі – FC, «Fetuses, Control», n = 10) 
включала ЩЗ плодів від матерів із фізіологічною вагіт-
ністю; групи Nо 2–4, або групи дослідження включали 
ЩЗ плодів, матері яких до вагітності зазнавали впливу 
Escherichia coli (FEC – «Fetuses, E. coli», n = 10), 
Staphylococcus aureus (FSA – «Fetuses, S. aureus», 
n = 8) та Klebsiella pneumoniae (FKP – «Fetuses, 
K. pneumoniae», n = 9).

Для вивчення морфофункціональних показників 
ЩЗ плодів використовували комплекс гістологічних, 
імунофлуоресцентних, морфометричних і статистич-
них методів дослідження. Парафінові зрізи завтовшки 
5–6 мкм забарвлювали гематоксиліном-еозином 
для ідентифікації органа та його основних структур, 
пікрофуксином за методом ван Гізона та за Маллорі 
для вивчення сполучних тканин ЩЗ. Виконали оптич-
ну мікроскопію на мікроскопі Carl Zeiss PrimoStar і 
мікрофотозйомку на камеру Carl Zeiss Axiocam 105 
color із програмним забезпеченням ZEN Blue Edition. 
На знімках виконали електронну морфометрію з 
використанням спеціалізованої програми для опра-
цювання зображень, у тому числі біологічних, ImageJ 
[22–24]. Для кожного зразка на збільшенні ×400 ок-
ремо вимірювали діаметр фолікула (120 вимірювань 
у 10 полях зору для кожного зразка), площу колоїду 
(120 вимірювань у 10 полях зору для кожного зразка), 
висоту й площу тироциту (210 вимірювань у 10 полях 
зору для кожного зразка), площу ядра та цитоплазми 
з обрахунком ядерно-цитоплазматичного індексу для 
клітини (210 вимірювань у 10 полях зору для кожного  
зразка).
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З використанням непрямого методу Кунса частину 
зрізів обробляли моноклональними антитілами (МКА) 
до тироксину (Т4) (Chemicon international), колагену І 
та ІІІ типів (Novocastra Laboratories Ltd), інтерлейкі-
ну-6 (IL-6) (Novocastra Laboratories Ltd) та фактора 
некрозу пухлини (TNF) (Novocastra Laboratories Ltd). 
Препарати вивчали з використанням люмінесцентно-
го мікроскопа Carl Zeiss Axioskop 40 FL з наступним 
захопленням зображень цифровою камерою CANON 
A520 й аналізом площ та інтенсивності світіння Т4, 
колагену І і ІІІ типів, IL-6 і TNF у програмі ImageJ за 
авторською методикою, що викладена далі. Кожне 
зображення, згідно з рекомендаціями розробників про-
грамного забезпечення [25], конвертували у «weighted 
RGB» (Edit > Options > Conversions) та калібрували 
(Analyze > Calibrate), далі за допомогою порогу 
кольорів і математичного алгоритму максимальної ен-
тропії (Image > Adjust > Threshold Color; надбудови: 
Tresholding method: MaxEntropy, Brightness – 55, інші 
параметри – без змін > кнопка «Select») визначали 
ділянки інтересу (region of interest – ROI), представ-
лені відокремленими ділянками флуоресценції. Далі 
аналізували частки (Analyze > Analyze Particles, над-
будови: Size (pixel ̂ 2): 0-Infinity, Circularity: 0.00 – 1.00, 
Show: Count Masks, позначки поряд із Display results 
і Summarize => кнопка «ОК») із кількісним визначен-
ням загальної площі зон світіння («Total Area») та 
оптичної щільності (OD = «Mean Gray Value»). Перед 
статистичним аналізом результати реплікаційних 
вимірювань, виконаних на одному зразку впродовж 
морфометрії та імунофлуоресцентного дослідження, 
були усереднені до одного значення.

Статистичний аналіз даних виконали у програмно-
му середовищі для статистичних обчислень R (ліцен-
зія: GNU GPL v.2) з використанням пакетів «ggplot2», 
«dplyr», «pastecs» та «graphics». Бібліотеки цих пакетів 
використали для визначення ступенів центральної 
тенденції та мінливості набору даних, виконання тесту 
Шапіро–Вілка на нормальність розподілу та перевірки 
рівності дисперсій кількох вибірок за допомогою крите-
рію Бартлетта. Коли дані не відповідали нормальному 
розподілу чи однорідності дисперсії, їх нормалізували 
за методом Бокса–Кокса. Після цього виконували 
однофакторний дисперсійний аналіз (ANOVA) для 
порівняння середніх значень кількісних ознак для кож-
ного показника, апостеріорні порівняння за методом 
Бонферроні та тесту Тьюкі (95 % рівень вірогідності) 
для контролю групової ймовірності помилки.

Для всіх статистичних критеріїв помилка першого 
роду встановлена на рівні 0,001. Нульову гіпотезу про 
відсутність відмінностей між групами відкидали, коли 
вірогідність помилки (p) не перевищувала помилку 
першого роду (p < 0,001). Результати наведено як 
M ± SD, де M – середня арифметична величина, а 
SD – стандартне квадратичне відхилення.

Утримання, догляд, здійснення експерименту, 
евтаназію, утилізацію біологічних матеріалів викона-
ли згідно з Директивою Європейського парламенту 
та Ради Європейського Союзу «Про захист тварин, 
яких використовують з науковими цілями» (2010 р.) і 
стандартів Good Laboratory Practice.

Результати
У всіх групах під час оглядової мікроскопії на збіль-
шенні ×40 визначили, що ЩЗ зовні вкриті сполуч-
нотканинною капсулою та мають дві (інколи – одну) 
бічні частки і перешийок. Бічні частки прилягають до 
латеральних поверхонь щитовидного або перснепо-
дібного хрящів трахеї залежно від рівня декапітації. 
Перешийок знаходиться спереду від трахеї, а дорсаль-
номедіальні поверхні бічних часток ЩЗ прилягають до 
стравохідно-трахейних жолобків. До зовнішніх відділів 
бічних часток залоз прилягають судинно-нервові спле-
тення шиї. Здебільшого у препаратах ЩЗ виявляли 
паращитовидні залози.

Гістологічна будова часток чотирьох експеримен-
тальних груп однотипна. Так, у часточках, що фор-
муються прошарками сполучнотканинної капсули, є 
секреторні клітини, які формували структури двох видів: 
фолікули, стінка яких представлена одним шаром клі-
тин, прилеглих до базальної мембрани, а вміст, якщо 
визначався, – гомогенним колоїдом; та екстрафоліку-
лярний епітелій, або подушечки Сандерса, – компактні 
скупчення клітин поза межами фолікулів із базально 
розташованими ядрами. С-клітини мали овальну фор-
му, кругле базофільне ядро та зернисту цитоплазму.

У контрольній групі (FC), ЩЗ представлена острів-
цями фолікулярного епітелію, що візуально нагадував 
десквамативний через щільне розташування тироци-
тів. Острівці були відокремлені сполучнотканинними 
прошарками з ледь помітними капілярами. Переважно 
в периферійних відділах органа спостерігали пооди-
нокі фолікули, заповнені оптично густішим колоїдом 
(рис. 1). Тироцити пласкої або кубічної форми, мали 
великі базально розташовані ядра з дрібними грудоч-
ками хроматину й обвід еозинофільної цитоплазми.

У групах дослідження (FEC, FSA, FKP) спостері-
гали аналогічну одна до одної гістоархітектоніку: ве-
ликі розвинуті фолікули та візуально невеликі острівці 
екстрафолікулярного епітелію. Просвіти фолікулів 
виглядали ширшими, а колоїд з явищами крайової 
вакуолізації виглядав більш рідким і фокально піни-
стим, виявляли також одинокі десквамовані тиро-
цити неправильної форми з темним ядром у стані 
каріорексису або каріопікнозу (рис. 2). Фолікулярний 
епітелій кубічно-циліндричної форми мав базально 
розташовані видовжені ядра, що виглядали меншими 
щодо цитоплазми, ніж у групі контролю.

Морфометрія ЩЗ показала, що в усіх групах 
дослідження (FEC, FKP, FSA) порівняно з групою 
контролю (FC) вірогідно збільшились показни-
ки: діаметр фолікула, Dfol (17,655 ± 0,641 µm, 
20,227 ± 0,169 µm, 19,284 ± 0,322 µm проти 
16,213 ± 0,661 µm відповідно, p < 0,001), площа 
фолікулу, Sfol (445,012 ± 2,313 µm2, 491,160 ± 1,531 
µm2, 497,304 ± 2,984 µm2 проти 233,804 ± 2,145 µm2, 
p < 0,001), площа колоїду, Scol (117,112 ± 2,626 
µm2, 122,716 ± 2,497 µm2, 128,663 ± 2,141 µm2 проти 
111,245 ± 2,963 µm2 відповідно, p < 0,001), висота ти-
роциту, Hthyr (10,353 ± 0,077 µm, 11,911 ± 0,054 µm, 
12,406 ± 0,056 µm проти 5,934 ± 0,070 µm відповід-
но, p < 0,001), площа тироциту, Sthyr (56,506 ± 0,332 
µm2, 64,581 ± 0,133 µm2, 65,413 ± 0,199 µm2 проти 
20,833 ± 0,587 µm2 відповідно, p < 0,001). Але 
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зменшилася площа ядра, Snuc (22,624 ± 0,069 µm2,  
24,389 ± 0,080 µm2, 27,388 ± 0,075 µm2 проти 
14,404 ± 0,055 µm2 відповідно, p < 0,001) щодо 
площі цитоплазми, Scyt (38,520 ± 0,175 µm2, 40,761 ±  
0,088 µm2, 41,931 ± 0,069 µm2 проти 12,731 ± 0,086 µm2,  
p < 0,001), що позначилося на зменшенні показ-
ника ядерно-цитоплазматичного відношення (NCR) 
(0,619 ± 0,096, 0,606 ± 0,070, 0,651 ± 0,091 проти 
1,112 ± 0,067 відповідно, p < 0,001). Найбільші від-
мінності від групи контролю за параметрами показала 
група FSA, а найнижчі – FEC.

Імунофлуоресцентне дослідження (ІФД) інтен-
сивності світіння таких маркерів функціональної 
активності ЩЗ, як Т4, колаген І і ІІІ типів, IL-6 і TNF 
показало результати: середня інтенсивність світіння 
фолікулярних тироцитів і колоїду у препаратах, що 
оброблені МКА до Т4, OD T4, в контрольній групі 
висока (79,820 ± 0,199 у. о.) (рис.  3), а у групах 
FEC, FKP, FSA вона ще вища, різниця статистично 
значуща (80,652 ± 0,217 у. о., 85,530 ± 0,132 у. о.,  

87,084 ± 0,204 у. о. відповідно, p < 0,001). Крім 
того, у групах дослідження виявили більші площі зон 
світіння, S T4, (133377 ± 710 px; 138247 ± 747 px; 
169089 ± 792 px проти 129090 ± 544 px, p < 0,001) 
(рис. 4).

ІФД процесів колагеногенезу показало, що у 
ЩЗ плодів групи контролю спостерігали слабке 
світіння колагену І і ІІІ типів, OD Col 1 і OD Col 3, 
(33,842 ± 0,158 та 31,522 ± 0,188 відповідно) в капсу-
лі, стінках судин і стромі ЩЗ, а у групах FEC, FKP і 
FSA визначили помірне збільшення площ експресії 
цих маркерів, S Col 1 та S Col 3 (98339 ± 105 px /  
40110 ± 972 px; 97879 ± 101 px/55148 ± 884 px;  
98138 ± 61 px/59094 ± 1178 px відповідно, 
p < 0,001); світіння у групах FEC і FKP – від слабкого 
до помірного (36,505 ± 0,183 у. о. / 38,246 ± 0,336 у. о.;  
40,170 ± 0,266 y. o./43,150 ± 0,165 у. о.). У групі FSA 
значення оптичної щільності відповідало помірному 
світінню колагену І та ІІІ типів (51,915 ± 0,234 у. о./ 
49,673 ± 0,138 у. о.).

 

 

Рис. 1. ЩЗ плода щура групи FC. Острівці щільно розташованих тироцитів, відокремлених сполучнотканинними прошарками (1) і поодинокий розвинутий фолікул (2) із 
густим колоїдом (3). Забарвлення гематоксиліном та еозином, ×400.

Рис. 2. ЩЗ плода щура групи FSA. Великий фолікул округлої форми (1), заповнений рідким і фокально пінистим колоїдом з явищами крайової вакуолізації (2); десквамо-
ваний тироцит неправильної форми (3) з темним ядром у стані каріопікнозу. Забарвлення гематоксиліном та еозином, ×400.

Рис. 3. Яскраве світіння тироцитів у препараті ЩЗ плода групи контролю, що оброблений МКА до Т4. Непрямий метод Кунса з МКА до Т4, ×600.

Рис. 4. Яскраве світіння тироцитів у препараті ЩЗ плода групи FSA, що оброблений МКА до Т4. Непрямий метод Кунса з МКА до Т4, ×600.
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ІФД функціональної активності популяції макро-
фагів ЩЗ плодів показав, що незалежно від групи 
експресія маркерів IL-6 і TNF, OD IL-6 і OD TNF 
залишалася слабкою, але у групі FSA порівняно з 
іншими групами кількісні показники світіння та IL-6, 
і TNF вірогідно вищі (30,316 ± 0,234 у. о./31,474 ±  

0,157 у. о.; 37,700 ± 0,190 у. о./42,983 ± 0,181 у. о.;  
36,633 ± 0,285 у. о./43,960 ± 0,222 у. о. проти 
43,096 ± 0,148 у. о./47,173 ± 0,083 у. о., p < 0,001). 
Середні значення основних показників морфофунк-
ціональної активності щитовидної залози наведені 
на рис. 5.
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Рис. 5. Середні значення показників морфофункціонального стану ЩЗ плодів щурів. 1: Dfol – діаметр фолікула; 2: Sfol – площа фолікула; 3: Snuc – площа ядра тиро-
циту; 4: Hthyr – висота ядра тироциту; 5: Sthyr – площа тироциту; 6: Sсyt – площа цитоплазми тироциту; 7: NCR – ядерно-цитоплазматичне відношення; 8: OD Col3 – 
оптична щільність світіння колагену ІІІ типу; 9: OD TNF – оптична щільність світіння фактора некрозу пухлини; 10: OD IL-6 – оптична щільність світіння інтерлейкіну-6;  
11: OD T4 – оптична щільність світіння тироксину; 12: OD Col1 – оптична щільність світіння колагену І типу.
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Обговорення
Морфофункціональні показники всіх груп досліджен-
ня (FEC, FSA, FKP) порівняно з групою контролю 
мали односпрямовані зміни: передусім привернуло 
увагу зменшення показника NCR на тлі збільшен-
ня висоти та площі тироцитів. Це явище завжди 
вказує на підвищення функціональної активності 
ЩЗ на час взяття тканини. За відомостями фахової 
літератури, саме NCR як прояв функціональної 
активності ядерно-цитоплазматичного апарату ти-
роциту – основний морфометричний параметр для 
оцінювання функціонального напруження тиреоїдної 
паренхіми, а інші параметри є тільки похідними від  
NCR [26,27]. 

Цікаво, що в усіх групах дослідження визначили 
збільшення діаметра фолікула, що є індикатором 
зниження синтетичної активності органа після народ-
ження [28], але в контексті розвитку плодової ЩЗ може 
вказувати і на прискорення темпів внутрішньоутроб-
ного дозрівання фолікулів.

Збільшення інтенсивності світіння тироцитів, 
коли зразки ЩЗ обробляли МКА до Т4, в усіх групах 
дослідження порівняно з групою контролю свідчить 
про підвищення секреції, накопичення T4 фолікуляр-
ним епітелієм і підтверджує факт функціонального 
напруження залози. З одного боку, цей стан може бути 
викликаний активацією гуморального імунітету матері 
у відповідь на інфекційний процес, а з іншого – безпо-
середньою дією тиреоїдних гормонів матері, котрі, як 
відомо, беруть активну участь у формуванні плодової 
ЩЗ до третього триместру вагітності, коли гіпофіз плода 
починає синтезувати тиреотропний гормон (ТТГ) [29]. 

За даними наукової літератури, зазвичай при 
інфекційній патології у крові спостерігають зниження 
рівня Т3, що індукує проліферацію таргетних до ти-
реоїдних гормонів клітин [30,31], як-от тироцитів ЩЗ 
плода. Це може призвести до прискорення темпів 
органогенезу ЩЗ і передчасного виснаження адап-
тивно-компенсаторних резервів.

Результати ІФД із МКА до колагену I і III типів 
підтвердили помірне посилення процесів колагено-

генезу у ЩЗ плодів, які розвивалися за умов мате-
ринсько-плодової інфекції. Порівнюючи результати за 
групами, виявили: середні значення оптичної щільнос-
ті та площ імунофлуоресценції колагену I та III типів 
найвищі у плодів, які розвивалися за умови впливу 
S. aureus. У групах FC, FEC, FKP оптична щільність 
і площа флуоресценції колагену III типу переважали 
над флуоресценцією колагену І типу, що корелює 
з результатами попередніх досліджень, за якими в 
організмі спочатку розвивається колаген III типу, а 
згодом визріває колаген І типу [32]. Однак у групі FSA 
показники світіння колагену І типу – вищі за відповідні 
показники ІІІ типу, що може свідчити про прискорене 
дозрівання ЩЗ під впливом агресивнішого чинника.

Незначне посилення експресії маркерів IL-6 і TNF 
при слабкому світінні у групах дослідження вказує на 
наявність потенціалів імунного запалення, посилення 
процесів колагеногенезу та, як результат, прискореного 
дозрівання ЩЗ унаслідок активації окислювального 
стресу [33,34].

Найбільш виражені морфофункціональні зміни 
у групах дослідження порівняно з групою контролю 
визначили у групі плодів, що отримані від матерів, ін-
фікованих S. aureus. Це може вказувати на істотніший 
морфогенетичний вплив цього збудника на систему 
«мати – плацента – плід». Найменший, але не менш 
важливий вплив мала материнсько-плодова інфекція, 
спричинена E. сoli, проміжне місце належить інфекції, 
що спричинена K. pneumoniae (рис. 6).

Отже, результати дослідження показали, що 
материнсько-плодові інфекції, спричинені бактері-
ями-опортуністами, можуть виснажувати адаптив-
но-компенсаторні механізми ЩЗ плода шляхом індукції 
проліферативної активності клітин ЩЗ у відповідь на 
тривалу антигенну стимуляцію та зміну рівня тире-
оїдних гормонів в організмі матері через підгострий 
інфекційно-запальний процес. Крім того, за даними 
фахової літератури, постійний вплив ушкоджувального 
фактора у крові та тканинах плода може призвести до 
виснаження вродженого імунітету власне щитовидної 
залози, який у нормі зумовлений запрограмованою 
здатністю тироцитів і клітин строми продукувати 
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прозапальні цитокіни через активацію Toll-подібних 
рецепторів [35].

Морфофункціональні зміни стану щитовидної 
залози нащадків щурів комплексно можуть бути 
передвісником передчасного виснаження адап-
тивно-компенсаторного резерву, що здійснюється 
шляхом клітинного й молекулярного компонентів 
вродженої імунної системи щитовидної залози. Отже, 
можна припустити, що в період постнатального онто-
генезу можливий розвиток автоімунного тиреоїдиту, 
але ця гіпотеза потребує підтвердження шляхом 
вивчення надалі морфофункціонального стану щи-
товидної залози у новонароджених за умов материн-
сько-плодових інфекцій, що спричинені Escherichia 
coli, Staphylococcus aureus і Klebsiella pneumoniae. 

Результати цього дослідження можна екстрапо-
лювати на людину.

Висновки
1. У щитовидній залозі плода щура, що зазнав 

впливу материнсько-плодових інфекцій, спричинених 
Escherichia coli, Staphylococcus aureus і Klebsiella 
pneumoniae, виявили морфофункціональні зміни, які 
є односпрямованими та вірогідно відрізняються від 
тих, що реєструють при фізіологічному органогенезі.

2. Ці зміни відповідають підвищенню секреторної 
активності залози; на це вказує зменшення ядерно-ци-
топлазматичного індексу, збільшення висоти та площі 
тироциту, посилення інтенсивності та збільшення 
площі флуоресценції Т4 у препаратах, що оброблені 
відповідними МКА.

3. Наведені тканинні реакції свідчать про приско-
рення темпів визрівання органа, що позначається 
збільшенням діаметра фолікула та посиленням інтен-
сивності флуоресценції колагену ІІІ типу в препаратах, 
оброблених відповідними МКА.

Перспективи подальших досліджень поляга-
ють у продовженні вивчення морфофункціонального 
стану щитовидних залоз новонароджених щурів за 
умов материнсько-плодових інфекцій, що спричинені 
Escherichia coli, Staphylococcus aureus і Klebsiella 
pneumoniae, а також хронічної внутрішньоутробної 
гіпоксії.
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	Рисунки
	Рис. 1. ЩЗ плода щура групи FC. Острівці щільно розташованих тироцитів, відокремлених сполучнотканинними прошарками (1) і поодинокий розвинутий фолікул (2) із густим колоїдом (3). Забарвлення гематоксиліном та еозином, ×400.
	Рис. 2. ЩЗ плода щура групи FSA. Великий фолікул округлої форми (1), заповнений рідким і фокально пінистим колоїдом з явищами крайової вакуолізації (2); десквамований тироцит неправильної форми (3) з темним ядром у стані каріопікнозу. Забарвлення гематоксиліном та еозином, ×400.
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